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CHAPTER 1 DOCUMENT STANDARDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

✓ gain an overview of the different types of business 
documents 

✓ gain an understanding of the different types of software 
available for producing business documents 

✓ gain an overview of who prepares business documents 

✓ gain an overview of the various ways of speeding up 
document production 

✓ gain an understanding of aspects to consider when 
developing document standards 

✓ learn how to view document properties 

✓ learn how to specify document properties 

✓ learn how to insert properties into a document. 

It is important that companies have standards and guidelines in 
place for document preparation and production. Documentation 
standards ensure that quality documents are produced in the most 
efficient manner. 

INFOCUS 
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TYPES OF BUSINESS DOCUMENTS 
 

 

 

 

  

 

A business must communicate with its 
customers, employees, suppliers, the 
government, and other businesses. This 
communication is mostly done through a variety 

of business documents. As a result there are a 
large number and variety of documents produced 
by businesses. 
 

A good way to understand the types of business documents produced in organisations is to examine the 
needs and requirements of the various parts of an organisation, and to group documents according to 
the functions performed. 

Management 

Management requires documents that help make business decisions and help keep the business 
running. These types of documents include: 

• Production reports 

• Sales reports 

• Meeting minutes 

Sales and Marketing 

Sales and Marketing require documents that help promote the business and its products to the 
customers. These types of documents include: 

• Price lists and order forms 

• Product brochures 

• Sales reports 

• Bulk mail-outs to customers 

Human Resources 

Human Resources deal with a variety of matters regarding employees. They require a very broad range 
of documents including: 

• Job descriptions 

• Employment forms 

• Training manuals and guides 

• Job procedures 

Manufacturing and Production 

Manufacturing and Production produce the goods and services sold by the business and require 
documents that help them produce these goods and services on time and in the most cost-effective 
manner. The types of documents they require include: 

• Production reports 

• Supplier price lists and forms 

• Product specifications and procedures 

Administration and Accounts 

Administration and Accounts are responsible for ensuring that the day-to-day operation of the business 
proceeds smoothly, that customers are invoiced, that bills are paid, that money is collected and banked, 
and the like. They require a variety of documents including: 

• Memos, faxes and letters 

• Sales reports 

• Accounting reports 
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CHOOSING APPROPRIATE SOFTWARE 
 

 

 

 

  

 

The large number of documents required for 
businesses to operate can be produced by a 
variety of software packages and applications. In 
fact, many of the documents can be produced by 

more than one type of software application. It is 
useful to know about the role and function of the 
various software applications. 
 

Type of Document Typical Software 
Application(s) 

Level of 
Sophistication 

Comments 

Production reports Spreadsheets 

Database 

Word processing 

Specialised production software 

Low For internal communication 
only 

Sales reports Spreadsheets 

Database 

Word processing 

Accounting software 

Low For internal communication 
only 

Meeting minutes Word processing Low For internal communication 
only 

Price lists Spreadsheets 

Database 

Word processing 

Accounting software 

Desktop publishing software 

Medium For internal use as well as 
external communication to 
customers 

Order forms Word processing 
Desktop publishing software 

Low For customer use 

Product brochures Word processing 

Desktop publishing software 

High For customer use 

Merge letters Spreadsheets 

Database 

Word processing 

Accounting software 

Medium Used to communicate to 
customers 

Job descriptions Word processing Medium For prospective job applicants  

Employment forms Word processing 

Desktop publishing software 

Low For internal use only 

Job procedures Word processing Low For internal use only 

Supplier price lists Spreadsheets 

Database 

Word processing 

Accounting software 

Low For internal use only 

Product 
specifications 

Database 

Word processing 

Accounting software 

Medium For customer use 

Memos, faxes, 
letters 

Word processing Low For internal and external 
communication 

Accounting reports Spreadsheets 

Database 

Word processing 

Accounting software 

Low For internal use 
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WHO PREPARES BUSINESS DOCUMENTS 
 

 

 

 

  

 

With such a diversity of business documents in 
use today, and with a variety of software 
applications available to create these documents, 
it is obviously not possible for one person or 

department to assume total responsibility for 
document preparation. So, who does prepare 
documents in a business? 

Standard Business Documents 

Standard business documents are relatively simple in layout, and are authored, printed and distributed 
by the same person within a company. These documents are usually memos, letters, faxes, minutes of 
meetings, and the like. The focus is more on the content and the subject matter than on the layout and 
overall appearance of the document. 

These would form the bulk of the documents produced within a company. 

These documents are usually produced on a personal computer or laptop and printed on the author’s 
printer. Increasingly, these documents are circulated internally via email rather than through the mail 
system. 

Large companies often have directives that specify how these documents should be laid out. In small to 
medium companies, however, the look and layout of these documents is less formal and left to the 
discretion of the author. Many authors simply use the templates found in word processing applications to 
assist them in the layout of these types of documents. 

Specialised Business Documents 

Specialised business documents are by nature more complex and difficult to produce. These types of 
documents are usually colour brochures promoting the company and its products, annual reports for 
shareholders and investors, and the like. Often they incorporate pictures and artwork (graphics), and are 
produced as full-colour documents on high quality paper. 

These documents are usually produced by a team of people. Some of these people work within the 
company, while others are contracted by the company to perform a specific job. For example, the 
content is usually prepared by people within the company that are expert in the products and services of 
the company. However, these people do not usually have professional design and printing skills so these 
aspects of document production are outsourced to an external company that specialises in layout, 
design and printing. 

Generally, there are three steps to the production of these types of documents. 

1. The text (also referred to as the ‘copy’) is prepared by the subject experts within the company. 

2. The text, relevant pictures and general information about the purpose of the document is handed 
over to a designer to lay out the design, choose the appropriate colours and fonts, and so on. 

3. The completed document is then provided in an electronic format to a printing company that 
prints the document in the quantities required by the company. 

Naturally, there should be someone within the company who manages and coordinates this process. If 
these documents are for sales and marketing purposes, it is usually someone from the marketing 
department who undertakes this role. 
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SPEEDING UP DOCUMENT PRODUCTION 
 

 

 

 

  

 

Most software applications that are used to 
produce business documents contain a number 
of features that can speed up the production of 
documents. There are also things that can be 

done within a company to ensure efficient and fast 
document production. Some of the software 
features and company tasks are detailed below. 
 

Features Found In Software 

Macros 

Originally, macros were simply recorded keystrokes that could be stored and executed over and over 
again. These were used for the production of documents, or parts of documents, that remained the same 
from document to document. The keystrokes, such as a series of sequential steps to complete a specific 
task or perform an action, were recorded when the first document was created. They could then be 
replayed to create more of the same types of documents. Today, macros still perform the same role. 
However, they are now based on sophisticated programming commands and languages and, while still 
relatively easy to use, offer much more power than earlier keystroke macros. 

Themes 

Themes let you create professional-looking documents with a co-ordinated set of colours, fonts and 
backgrounds in a flash. By applying one of the 40 built-in themes you can change the overall look of your 
document immediately. To make the best use of themes, however, you will need to apply styles (via the 
Home tab) to the various elements in the document. 

Templates 

One of the most tedious tasks in document production is designing the layout and overall presentation of 
a document. A template allows you to create a document based on an existing design and can save 
much production time. Templates can also be created from an existing document. The existing 
document is converted into a template and the design of that document can then be used to produce 
future documents. 

Styles 

Longer documents require consistency in the look of their headings, text, tables, and the like. Styles in 
word processing applications allow you to store a set of formatting attributes and then apply that 
formatting to different parts of the document. For example, you can create a style for main headings that 
consists of a range of formatting attributes, such as a specific font style, font size, adjusted paragraph 
spacing, etc. You can then apply that style to any text that you want to use as a main heading. If you 
later want to change the way those headings look, you only need to change the style and all of the 
headings will automatically update. Styles can save a considerable amount of time in document 
production. 

Building Blocks 

You can recycle content that you use constantly in your business, such as contracts, agreements, 
procedures and the like, by creating and using building blocks. For example, you might save your 
company’s contact information as a building block in the Quick Parts gallery, and whenever you require 
that information, you can simply open the Quick Parts gallery and select the desired building block. 

Speeding Up Document Production 

Guidelines and standards 

One of the most time-consuming aspects of document production is deciding how you want it to look – 
what fonts to use, colours, margin settings, headers, footers, and so on. It is extremely beneficial for any 
company to have a set of procedures and guidelines that define these aspects of document production 
for authors. Every company, even the smallest, will decrease production time by having a set of 
standards in place. In addition these should be incorporated into a standard set of company templates 
(see above) which can be easily accessed by authors. 
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ESTABLISHING DOCUMENT STANDARDS 
 

 

 

 

  

 

It is important for all companies, both small and 
large, to have a set of guidelines and standards 
in place for document production and handling. 
These guidelines ensure a consistent look and 

feel amongst the documents, allow new employees 
to become quickly acquainted with document 
production, and convey a professional image of the 
company to its customers and clients. 
 

Things To Consider When Developing Document Standards 

Storage 

It is important that company documents can be located and accessed by relevant people. Documents 
can be stored on a personal computer or on a network server. If company documents are stored on a 
personal computer, and if those documents are to be made available to other users, then the documents 
should be stored in shared folders that are accessible to other users on the network. Generally, it is 
advisable for public documents to be placed on a network server if one exists. Some liaison with the 
network administrator may be necessary to ensure that document authors have appropriate access 
rights to the network. 

Folder and file naming 

It is important that the company implements a standard for file and folder naming. Using proper 
guidelines ensures that important documents can be found easily in the future. A handy technique used 
in document production is to include the file name and folder path somewhere in the document. This can 
be in the header, the footer, on the front or last page, or even in the document properties. The desired 
method should be clearly detailed in the company guidelines. 

Templates 

Detailed information should be placed in the guidelines with regard to what templates are available for 
document production. There should also be instructions explaining how the templates are to be used, 
where they can be accessed, and appropriate information detailing what can and what can’t be altered in 
the templates. 

Company logos, colours and general branding 

Most companies have an established logo, colour scheme and other form of branding. The guidelines 
should clearly indicate what these are, what the minimum and maximum sizing for logos is, the 
placement of logos, the colour of the text, and other branding issues. 

Styles 

The document guidelines should contain information about the size of font, line and paragraph spacing, 
and indents that are to be used for the body text (the general text), headings, table text, figure text, 
captions, and other text in the document. 

Output 

The document guidelines should include detailed information about how the document should be 
produced. For example, many computer printers will print in draft mode and quality mode. The guidelines 
should indicate when it is appropriate to print the document in quality mode (which is more expensive 
and sometimes slower). Also, it is increasingly popular to transmit documents electronically via email. 
The guidelines should indicate when documents are to be printed on paper and when they are to be 
transmitted electronically. 

Review of standards 

It is not possible to lock in standards forever – needs and technology are changing too fast to make this 
possible. Consideration should be given, therefore, as to how frequently the standards will be reviewed 
and how the amendments will be provided to the user. 
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VIEWING DOCUMENT PROPERTIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are several ways to view document 
properties. The Properties pane via Info in 
Backstage view displays basic summary 
properties, most of which you can edit. As well as 

the Properties pane, you can view and add 
properties to the Document panel, which is 
displayed on the screen under the ribbon.  
 

Try This Yourself: 

O
p

e
n

 

F
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Before starting this 
exercise you MUST 
open the file 
Properties_1.docx… 

 
Click on the File tab and 
ensure that Info is 
selected 

The Properties pane will 
appear on the right side 
of the screen, displaying 
common properties. 
Let’s view more 
properties… 

 
Click on Show All 
Properties under 
Related Documents in 
the bottom right of the 
screen to expand the list 
of properties 

The pane will expand to 
display all editable 
document properties  

 
 

For Your Reference… 

To view document properties: 

1. Click on the File tab and select Info 

2. Click on Show All Properties to view all 
summary properties, or 

 Click on [Properties] and select Show 
Document Panel  

Handy to Know… 

• The Properties pane displays all editable 
properties, while the Document panel 
displays common, editable properties. 

• Click on Open File Location in the 
Properties pane to open File Explorer and 
display the folder where the document is 
saved. 
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SPECIFYING DOCUMENT PROPERTIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

You can add data to your document properties at 
any time. Specifying document properties such 
as keywords or tags, can help you or others to 
search for and identify the file in future. You can 

add data to your document’s properties in the 
Properties pane or in the Document panel. Some 
information is added by Word, but you can add and 
edit data according to your needs.  
 

Try This Yourself: 

S
a

m
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Continue using the previous 
file with this exercise, or 
open the file 
Properties_2.docx... 

 
Ensure the Info section of 
the Backstage is displayed, 
then click in Add a Title and 
type Staff Induction 
Information 

 
Press  to move to Tags 

and type Induction, new 
staff, hazards, telephone 
faults, ergonomics, 
passwords 

 Let’s update the Author 
property in the Properties 
panel… 

 
Right-click on the value in 
Author and select Remove 
Person 

The field will now have no 
data… 

 
Click on Add an author and 
begin typing your name 

If your name is in the 
company address book, it 
will appear in the pane 
below… 

 
If your name appears, click 
on it to add it or continue 
typing your name and press 

  

 
Click on the Back arrow to 
return to the document 

 

1 2 

3 

For Your Reference… 

To specify document properties: 

• Click on the File tab, select Info, click on 
View All Properties, click in a field, then 
type the required data, or 

• Click on the File tab, select Info, click on 
[Properties], select Show Document Panel 
then add the required data  

Handy to Know… 

• When you create a new document, the 
Author field displays the User name 
specified in Word Options. To update the 
default user name, click on the File tab and 
select Options. In the General options, 
select the text for User name and type your 
name. Click on [OK]. 
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INSERTING PROPERTIES INTO A DOCUMENT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

One of the advantages of maintaining document 
properties is that you can insert property data into 
a document, such as the author or company 
name. This is done by inserting content controls 

that hold the data into the document. Not only is 
this a quick method of inserting standard 
information into a document, but it will also update 
automatically when the property data changes.   
 

Try This Yourself: 

O
p

e
n

 

F
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Before starting this 
exercise you MUST 
open the file 
Properties_4.docx… 

 
Click at the end of the 
first heading and press 

 to create a new line 

 
Type Prepared by: and 
press   

 
Click on the Insert tab, 
then click on Quick 
Parts in the Text group 

 
Point to Document 
Property, then select 
Author 

The author’s name will 
appear in the Author 
content control... 

 
Press   

 

2 

3 

4 

For Your Reference… 

To insert property data into a document: 

1. Click where you want to insert the content 
control 

2. Click on the Insert tab, then click on Quick 
Parts and select Document Property 

3. Select a property field name  

Handy to Know… 

• If the property field that you want to insert 
does not appear in the Document Property 
list, select Field instead. This displays the 
Field dialog box and gives you access to a 
full list of content controls that you can insert. 
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CHALLENGE EXERCISE 
Document Standards 
    

 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Document Standards… 

 

 
In the space provided on the next page, list the three types of documents 
that a business may need to produce 

 

 
In the space provided on the next page, name the typical application that 
you could use to create the following documents: 

Accounting reports 

Job descriptions 

product brochures 

Price lists 

Hint: Choose your answer from the list provided… 

 

 
In the space provided on the next page, list two general features found in 
software that speed up production 

 

 
In the space provided on the next page, list two aspects that you might 
consider when establishing document standards 

 

 
Photocopy the next page with your completed answers  

 

Files required for 
exercise: 

None 

Files/work created by 
student: 

Photocopy of your answers from the next page 

Exercise Completed:  
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CHALLENGE EXERCISE WORKSPACE 
Document Standards 
    

 

What are three types of documents that a business may need to produce? 

1. 

2. 

3. 

For each of the following document types, what is the typical application that you could 
use to create them? 

Choose your answers from: Desktop publishing software, spreadsheet software, 
accounting software, word processing software. Use each option once only… 

Accounting reports: 

Job descriptions: 

Product brochures: 

Price lists: 

List two general features found in software that speed up production 

1. 

2. 

What are two aspects that you should consider when establishing document standards? 

1. 

2. 

 

1 

2 

3 

4 
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NOTES: 
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